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Scope of Manual

Preface

NightView is a general purpose source-level program debugger. Some of the features
make it useful for debugging systems of real-time programs, but it can also be used to
debug a single ordinary program.

NightView can debug programs written in multiple languages. C, C++ and Fortran are
supported.

NightView can debug multiple processes on the local system or on different hosts.

NightView has been designed to be as flexible as possible. The NightView command
interpreter includes macro processing so that you can write your own NightView com-
mands.

You communicate with NightView with one of three user interfaces. The command-line
interface is useful when no advanced terminal capabilities are present. A simple full-
screen interface is available for Ascil terminals. The graphical user interface provides the
most functionality.

This document is the user manual for the NightView debugger. It isintended for anyone
using NightView, regardiess of their previous level of experience with debuggers. This
manual describes how to use NightView, by way of tutorial and reference guide. Thereis
also material for system administrators.

Structure of Manual

The manual begins with the short tutorials, Chapter 1 [A Quick Start] on page 1-1 and
Chapter 2 [A Quick Start - GUI] on page 2-1, giving you just enough information to get
you started. For more complete tutorial, see Chapter 4 [Tutorials] on page 4-1.

The next section describes the major concepts you will need to understand in order to get
the best use out of NightView. See Chapter 3 [Concepts] on page 3-1.

More detailed information about the NightView commands is found in Chapter 6 [Com-
mand-Line Interface] on page 6-1.

The next chapter describes a simple full-screen interface to NightView. See Chapter 7
[Simple Full-Screen Interface] on page 7-1.

The next chapter describes the graphical user interface for NightView. See Chapter 8
[Graphical User Interface] on page 8-1.

Thismanual also contains several appendixes that may not be of interest to all users, such
as an implementation overview. A glossary of termsrelated to NightView and aquick ref-
erence guide are also provided.
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Syntax Notation

The following notation is used throughout this guide:
italic

Books, reference cards, and items that the user must specify appear in italic
type. Specia terms and commentsin code may also appear in italic.

list bold

User input appearsin 1ist bold type and must be entered exactly as
shown. Names of directories, files, commands, options and man page refer-
ences also appear in 1ist bold type.

list

Operating system and program output such as prompts and messages and list-
ings of files and programs appearsin 1ist type. Keywords also appear in
list type.

window

K eyboard sequences and window features such as push buttons, radio buttons,
menu items, labels, and titles appear in window type.

Brackets enclose command options and arguments that are optional. You do
not type the brackets if you choose to specify such option or arguments.
Mutually exclusive choices are separated by the pipe (|) character.

{}

Braces enclose mutually exclusive choices separated by the pipe (| ) character,
where one choice must be selected. You do not type the braces or the pipe
character with the choice.

An dlipsisfollows an item that can be repeated.

This symbol meansis defined as in Backus-Naur Form (BNF).

Related Publications

The following publications are referenced in this document:

0897008 NightSar LX Installation Guide
0897008 NightSar LX Tutorial




Reporting Bugs

0897398 NightTrace™ User’s Guide
0897465 NightProbe™ User’s Guide
0897515 NightTune™ User’s Guide

Preface

Please report any bugs you encounter. Software support is available from the Concurrent
Software Support Center at our toll free number 1-800-245-6453. For calls outside the
United States, the number is 1-954-283-1822. The Software Support Center operates
Monday through Friday from 8 am. to 5 p.m. Eastern Standard Time. You may also sub-
mit a bug report or arequest for assistance at any time by using the Concurrent Computer
Corporation web site at http://www.ccur.com/isd_support_contact.asp or by sending an
email to support@ccur.com.
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1
A Quick Start

This chapter is for people who want to start using the command-line version of the
debugger before reading the whole manual. You may also be interested in the graphical-
user-interface (GUI) version of this chapter in Chapter 2 [A Quick Start - GUI] on page
2-1. Thereisamore thorough tutorial in Chapter 4 [Tutorials] on page 4-1.

If you are familiar with the GNU debugger, gdb™, you should have very few problems
with NightView. The commands are aimost all identical. The biggest difference
between NightView and other debuggers is how you tell NightView what program to
debug and how you start that program.

If you get any errors, the error message tells which section of the manual can help you
determine what went wrong. At any time, you can ask the debugger to display help on an
error message by mentioning that section's name as the argument to the help command
(see“help” on page 6-143).

The rest of this chapter goes through a sample debug session on a small program. Feel
free to dive right into the debugger. If you get into trouble, use the help command to
get out of it.

Sample Program

This section lists the program used as an example through the remainder of the chapter.
The program does not have any bugs in it; it will be used to show how to run a program,
set breakpoints, look at variables, etc. You can copy this file from /usr/lib/
NightView/fact.c into your own directory. The following program is in the file
fact.c:

1-1
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1 #include <stdio.h>

2

3 static int factorial (x)

4 int x;

5

6 if (x <= 1) {

7 return 1;

8 } else {

9 return x * factorial (x-1) ;
10 }

11}

12

13 wvoid

14 main(argc, argv)

15 int argc;

16 char ** argv;

17 |

18 int i, errors;

19 for (1 = 1; i < argc; ++1i) {
20 long x1;

21 int x;

22 int answer;

23 char * ends = NULL;

24 x1 = strtol (argv[i], &ends, 10);
25 x = (int)xl;

26 answer = factorial (x) ;

27 printf ("factorial ($d) == %d\n", x, answer) ;
28 }

29 exit (0) ;

30 }

The remainder of this chapter assumes that you compiled fact.c and put the resulting
executablein fact:

cc -g -o fact fact.c

You can start NightView with or without a program name. If you start it with a program
name, NightView runs the program in a dialogue shell (see “Dialogues’ on page 3-4). If
you start NightView without a program name or you want to debug another program, you
must execute the program with the run command (see “run” on page 6-35) in a dialogue
shell.

Below is an example of starting up the debugger with a program name and a program
argument. Note that throughout the quick start, the version and the link time might not
match exactly for your version of NightView. Also, some of the shell output and other
messages may not come out exactly as shown. Some messages might not appear, or
additional messages might appear, depending on your environment.
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$ nview -nogui ./fact 7
NightView debugger - Version 7.1, linked Fri Jun 8 10:24:51 EDT 2007
Copyright (C) 2007, Concurrent Computer Corporation

In case of confusion, type "help"

Note that you invoked NightView with a program name argument . /fact and program
argument 7. NightView responded with information about the debugger.

New process: local:2347 parent pid: 2340
Process local:2347 is executing /users/bob/fact.
Reading symbols from /users/bob/fact...done
Executable file set to /users/bob/fact
/usr/lib/NightView/ReadyToDebug

$ /usr/lib/NightView /ReadyToDebug

$./fact 7

(local)

NightView always runs a special program, /usr/1lib/NightView/ReadyToDebug.
This program helps NightView synchronize with the shell. That's why you see that line
in the output. You might see only one echo of /usr/lib/NightView/
ReadyToDebug, depending on how quickly the dialogue shell starts. The dollar signs
("$") are prompts from the shell.

NightView automatically created a dialogue named local; it aso displayed the string
local asthe prompt, showing that by default, commands apply to that dialogue (or the
processes running in that dialogue).

The debugger waited for the new program to get started. Because sending input to a
diaogue isjust like typing commands to a shell (the dialogue is really running the same
shell program you normally use), this caused the £act program to be executed with the
single argument 7.

If the fact program had required input, you would have used the ! command to send the
input to the program. See“!” on page 6-32.

When the dialogue executed the program, NightView got control and informed you that a
new process was just started in dialogue 1ocal and told you that the process id was
2347.

Because this is the only program running in dialogue 1ocal, you do not have to do
anything special to cause any commands you type to refer to this process; the default
qualifier is already set to local, so commands will automatically apply to the one
process running there.

Next you will enter a bogus command. Note that throughout this section, the help text
and display size may not exactly match your NightView session.

(local) foo
Error: Unrecognized command "foo". [E-command proc003]

NightView responded to the bogus command with an error message and an error code
([E- command proc003]).



NightView LX User’s Guide

Now get NightView to tell you more about the error message.

(local) help
E-command_proc003:
Unrecognized command "string".

STRING is not a valid NightView command. See "Summary of
Commands" .

You typed help without any arguments to see more information about the error
message. NightView showed the extended error information.

In the command-line and simple screen interfaces, online help is available only for error
messages. Consult a printed manual or view the online help with NightView's graphical
user interface.

If you are familiar with gdb, the remainder of this chapter will be fairly boring because
(once you get the program started) NightView and gdb look very much alike (at least for
all the commands demonstrated in this simple example).

Setting a Breakpoint

1-4

Y ou will now usethe 1ist command to ook at the source.

local) 11
#include <stdio.h>

static int factorial (x)
int x;

|

|

|

|

|

| if (x <= 1) {
* | return 1;

| } else {

|

|

1

(
1
2
3
4
5
6
7
8
9 return x * factorial (x-1);}
1

(

You told the 1ist command (abbreviated to 1 in this example) to list at line 1.

Y ou now decide where you want to set a breakpoint. An interesting spot in this program
is the return statement in the recursive routine factorial whereit is about to start
backing out of the recursive calls.

(local) b 7
local:2347 Breakpoint 1 set at fact.c:7
(local)

The return was on line 7, so you used the breakpoint command (abbreviated to b)
to set abreakpoint online 7.

Complete descriptions of the commands you used here appear in “list” on page 6-77 and
“breakpoint” on page 6-101.
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Now run the program until it reaches the breakpoint.

(local) ¢

local:2347: at Breakpoint 1, 0x100026fc in factorial (int
X = 1) at fact.c line 7

7 B=| return 1;

(local)

Y ou used the continue command (abbreviated to ¢) without any arguments. This told
the program to start running. It ran until it hit the breakpoint that you had set on line 7.
Note that your process ID and addresses will differ.

Now look at the call stack.

(local) bt

#0 0x100026fc in factorial(int x = 1) at fact.c line 7
#1 0x1000271c 1in factorial(int x = 2) at fact.c line 9
#2 0x1000271c 1in factorial(int x = 3) at fact.c line 9
#3 0x1000271c 1in factorial(int x = 4) at fact.c line 9
#4 0x1000271c 1in factorial(int x = 5) at fact.c line 9
#5 0x1000271c 1in factorial(int x = 6) at fact.c line 9
#6 0x1000271c 1in factorial(int x = 7) at fact.c line 9

#7 0x10002784 in main(int argc =
char **argv = 0x2ff7eaec)
at fact.c line 26

|
N

(local)

You used the bt (backtrace) command to display the call stack. You saw all the
expected recursive calls (see “backtrace” on page 6-86).

Now look at the value of the variable x.

You used the p (print) command to print the variable x, verifying that it was equal to
1.

Now finish running the program.

NOTE

If your system has debug information installed for system librar-
ies, the process may appear to be stopped inthe exit () library
routine after the command below. If so, enter the command up
until the debugger reports that the processisin main.
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(local) ¢
factorial (7) == 5040
Process local:2347 is about to exit normally
#0 0x100027ac in main(int argc = 2,
unsigned char **argv = 0x2ff7eaec)

at fact.c line 29
29 <>| exit (0) ;
(local)

Y ou used the ¢ (continue) command to allow the process to run to completion.

Exit from NightView.

Finally you typed q (quit) to leave the debugger. The fact program had not fully
exited, so NightView prompted, asking if the program should be killed. Y ou responded
with y, and the sample session ended. The commands used in this section appear in
“continug” on page 6-124, “backtrace” on page 6-86, “print” on page 6-86, and “quit” on

(local) g

Kill all processes being debugged? y
You are now leaving NightView...
Process local:2347 exited normally
Dialogue local has exited.

$

page 6-22.

1-6



2
A Quick Start - GUI

This chapter is for people who want to start using the graphical-user-interface (GUI)
version of the debugger before reading the whole manual. Y ou may also be interested in
the command-line version of this chapter in Chapter 1 [A Quick Start] on page 1-1. There
isamore thorough tutorial in Chapter 4 [Tutorials] on page 4-1.

In this manual, the words click, drag, press, and select always refer to mouse button 1.

This entire manual is available through the online help system built into the debugger. If
you get any errors, the error message tells which section of the manua can help you
determine what went wrong. At any time, you can ask the debugger to display any
section of the manual by clicking on the Help menu or using the H mnemonic. See
“Help Menu” on page 8-18. Click on the NightView User’s Guide menu item or use
the U mnemonic. NightView puts up a Help Window that displays the table of contents
for the manual. See “Help Window” on page 8-93. Y ou can read this manua section by
clickingon A Quick Start - GUI.

The rest of this chapter goes through a sample debug session on a small program. Feel
free to dive right into the debugger. If you get into trouble, use the Help menu to get out
of it.

Sample Program - GUI

This section lists the program used as an example through the remainder of the chapter.
The program does not have any bugs in it; it will be used to show how to run a program,
set breskpoints, look at variables, etc. You can copy this file from /usr/lib/
NightView/fact.c into your own directory. The following program is in the file
fact.c:

2-1
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1 #include <stdio.h>

2

3 static int factorial (x)

4 int x;

5

6 if (x <= 1) {

7 return 1;

8 } else {

9 return x * factorial (x-1) ;
10 }

11}

12

13 wvoid

14 main(argc, argv)

15 int argc;

16 char ** argv;

17 |

18 int i, errors;

19 for (1 = 1; i < argc; ++1i) {
20 long x1;

21 int x;

22 int answer;

23 char * ends = NULL;

24 x1 = strtol (argv[i], &ends, 10);
25 x = (int)xl;

26 answer = factorial (x) ;

27 printf ("factorial ($d) == %d\n", x, answer) ;
28 }

29 exit (0) ;

30 }

The remainder of this chapter assumes that you compiled fact.c and put the resulting
executablein fact:

cc -g -o fact fact.c

Starting Up - GUI

2-2

You can start NightView with or without a program name and arguments. If you start it
with a program name, NightView begins debugging the program immediately. If you
start NightView without a program name, or you want to debug another program, you
may run the program with the Run menu item in the Process menu, or by typing in the
shell in ashell panel. See “Shell Panel” on page 8-60. In either case, the program is run
in adialogue shell (see “Diaogues’ on page 3-4).

Below is an example of starting up the debugger with a program name and a program
argument. Note that throughout the quick start, the version and the link time might not
match exactly for your version of NightView. Also, some of the messages might not
come out exactly as shown. Some messages might not appear, or additional messages
might appear, depending on your environment.
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$ nview ./fact 7
NightView displays the main window. See“Main Window” on page 8-4.

Starting the debugger with the program name . /fact and argument 7 sent the line ./
fact 7 to the local dialogue and caused the debugger to wait for the new program to
get started. Because sending input to a dialogue is just like typing commands to a shell
(the dialogue is really running the same shell program you normally use), this caused the
fact program to be executed with the single argument 7.

If the fact program had required input, you would have typed the input into a shell
panel. See“Shell Panel” on page 8-60.

The message panel (see “Message Panel” on page 8-61) contains a message like the
following:

New process: local:2347 parent pid: 2340
Process local:2347 is executing /users/bob/fact.
Reading symbols from /users/bob/fact...done
Executable file set to

/users/bob/fact

When the dialogue executed the program, NightView got control and informed you that a
new process was just started in dialogue 1ocal and told you that the process id was
2347.

The status bar at the bottom of the window displays the program name, fact, the dialogue
name and PID, local:2347, and the state, Stopped for exec. See “Status Bar” on
page 8-24. The source panel title bar displays the program name, the dialogue name and
PID, and the name of the source file, fact.c. The source code from file fact . ¢ appears
in the source panel, centered around main. See“Source Panel” on page 8-53.

GUI

Next you will enter a bogus command. Note that throughout this section, the help text
and display size may not exactly match your NightView session.

The command toolbar is labeled Command:. Click in the combo box of the command
toolbox (see“Command Toolbar” on page 8-20) and issue the following command:

foo

Press Return to enter the command.

NightView responded to the bogus command with the following message and error code:
Error: Unrecognized command "foo". [E-command proc003]

Now get NightView to tell you more about the error message. Click on the Help menu or
use the H mnemonic. See “Help Menu” on page 8-18. Click on the On Last Error
menu item or use the E mnemonic. NightView puts up a Help Window that displays the
following extended error information:
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E-command_proc003
MESSAGE

ERROR: Unrecognized command "string".

EXPLANATION

string is not avalid NightView command. See Summary of Commands.

Next, dismiss the Help Window by selecting Exit from the File menu. See “Help
Window” on page 8-93.

Next you will read about the 1ist command. Click on the Help menu or use the H
mnemonic. See “Help Menu” on page 8-18. Click on the On Commands menu item
or use the m mnemonic. NightView puts up the following Help Window with a menu of
NightView commands.

Summary of Commands

This section gives asummary of all the commandsin NightView. Thetableis
organized alphabetically by command. The abbreviations for the commands are
included with the corresponding commands, rather than alphabetically.

Also, remember that you can abbreviate commands by using a unique prefix.
!
Pass input to adialogue.
apply on dialogue
Execute on dialogue commands for existing dialogues.
(etc.)

Most of the information would not fit on your display. The Help Window showed this by
having only a small thumb or slider on the vertical scroll bar. Scroll down to the 1ist
command by moving the thumb or by clicking on the arrow heads of the vertical scroll
bar. Click onthe 1ist command. NightView displayed the following Help Window with
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information about the 1ist command.
list
List asourcefile. Thiscommand has many forms, which are summarized below.
list where-spec
List ten lines centered on the line specified by where-spec.
1list where-specl, where-spec2
List the lines beginning with where-specl up to and including the where-spec2 line.
(etc.)

To see more about the 1ist command, you could move the thumb or click on the arrow
heads of the vertical scroll bar. However, rather than reading more, you make the Help
Window go away by selecting Exit from the File menu.

Setting a Breakpoint - GUI

Finishing up -

Y ou now decide where you want to set a breakpoint. An interesting spot in this program
is the return statement in the recursive routine factorial where it is about to start
backing out of the recursive calls.

Right-click on the line with the return statement (line 7) in the source panel. The line
becomes highlighted and a context menu appears. See “Source Panel Keystrokes’ on
page 8-59. Select thefirstitem, Set Simple Breakpoint.

The source line decoration beside line 7 isnow astop sign @ to indicate a breakpoint.

See “breakpoint” on page 6-101 and “Source Line Decorations’ on page 6-83. The
eventpoint panel now has an entry for the breakpoint.

The message panel shows:

local:2347 Breakpoint 1 set at fact.c:7

GUI

Now you want to run the program until it reaches the breakpoint. Click on the Resume
button in the process toolbar. See “Process Toolbar” on page 8-20.

Clicking on Resume told the program to start running. It ran until it hit the breakpoint
that you had set on line 7. The source line decoration beside line 7 is now a stop sign
overlaid with a triangle pointing to the right @ to indicate where execution will
resume.
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NightView responds with:

local:2347: at Breakpoint 1, 0x100026fc in factorial (int
x = 1) at fact.c line 7

Note that your process ID and addresses will differ. The status bar indicates the processis
Stopped at breakpoint 1. Now look at the call stack. The context panel and the
locals panel are in the same area with tabs below them. Click on the Context tab. The
context panel has an entry for each frame on the stack, displayed in tree form. See
“Context Panel” on page 8-64. You see all the expected recursive calls. Scroll to the
bottom of the panel. One of the icons is an arrowhead pointing down. = Click that
icon to show more stack frames, until you see the call to main. Then scroll to the top
again and click on the first frame.

Now look at the local variables. Click on the Locals tab. You see the local variables
displayed in tree form. In this case, there is only one loca variable, x. The locals panel
tracks the current context, which you set when you clicked in the context panel. The
valueof x inthisframeis1. See“LocalsPanel” on page 8-64.

Now finish running the program. Click on the Resume button. See “Process Toolbar”
on page 8-20.

This allowed the process to run to completion. The program printed a message, which
appeared in the message panel:

factorial (7) == 5040

NOTE

If your system has debug information installed for system librar-
ies, the process may appear to be stopped inthe exit () library
routine. If so, click the Up button f until the debugger reports
that the processisin main.

NightView showed the call to exit (0) in the source panel and displayed the following
message in the message panel.

Process local:2347 is about to exit normally

Exit from NightView by selecting the File menu. See “File Menu” on page 8-4. Click on
File or use the F mnemonic. Click on the Exit NightView menu item or use the X
mnemonic.

NightView responds with a warning dialog box. The warning dialog box says:
Kill all processes being debugged?

Finally you click on the OK button to leave the debugger. The £act program had not
fully exited, so NightView prompted, asking if the program should be killed. You
responded by clicking OK, and the sample session ended.
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Concepts

This section describes concepts you will need to understand in order to use the debugger
effectively.

Many of the concepts described in this section are also defined in the glossary. The
glossary is an aphabetical list of the concepts — the description here is organized
hierarchically.

Debugging

The term debugger is actually a misnomer. A debugger does not remove bugs from your
program. Instead, it is a tool to help you monitor and examine your program so that you
can find the bugs and remove them yourself.

A debugger primarily lets you do two things:

1. start and stop the execution of your program; and,

2. examine and alter the contents of the program's memory.

There are many ways to do these things, so there are lots of debugger commands. Also,
some of the commands control the debugger itself.

NightView is a symbolic debugger. That means that you can talk about your program
using the same high-level language constructs that you use when you write programs.
You can refer to variables, expressions and procedures as they appear in your program
source. You can aso refer to source files and line numbers within those files. For
example, you can tell your program to stop at a particular line. In order to use the
symbolic capabilities of the debugger, you must compile and link your program with
options that tell the compiler and linker to save the symbolic information along with your
program.

Sometimes, you want to be able to debug at a lower level, referring to machine language
instructions and registers. NightView lets you do that, too.

Accessing Files

During the course of debugging, NightView will likely have to access a number of files:
executable files for programs being debugged, source files for those programs, and
possibly object and library files. Those files must al reside, or be accessible from, the
system on which NightView is executing.

31
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If you are debugging processes running on some other system, you will probably want to
have some of that system'’s files mounted via NFS™ on the system running NightView.
Furthermore, your debugging will probably go much easier if the pathnames to those files
(especidly the executables) are the same on both systems. This will allow NightView to
find the executable files automatically most of the time. See “Finding Y our Program” on
page 3-9. If the pathnames of the executable files are different, you can use the
translate-object-file command to tell how to trandate the names. See
“tranglate-object-file” on page 6-27. In addition, remote files can be specified by using
the form userehost : /path. See “Remote File Access’ on page 3-7.

Programs and Processes

It is necessary to distinguish between a program and a process. A program is something
that you write, compile and link to form a program file. A process is an instance of
execution of a program. There may be several processes running the same program.

Multiple Processes

Families

3-2

The most typical use for NightView is debugging a single program running as a single
process, but NightView can also be used to debug an application consisting of multiple
processes, so the debugger has ways to describe multiple processes. If you come to a
section of the manual that describes multiple processes, and you are only debugging one
process, you can usualy just ignore the parts about multiple processes.

You may inadvertently create multiple processes, even though you only want to debug
one. This may happen if your program forks. For example, your program may call
system. This cal works by using the fork service to create another process, which
then runs a shell. A process created this way is caled a child process. Because
NightView has the capability of debugging child processes, you are notified when this
happens. If you don't want to debug the child process, then you should detach from it,
which alows it to run without further interference from the debugger. See “detach” on
page 6-38. If you know in advance that you don't want to debug any child processes, you
can usethe set-children command to specify this. See “set-children” on page 6-49.

If you use pipelines in the dialogue shell, or invoke shell scripts which call many other
programs, you are likely to get multiple processes which you are not interested in
debugging. (Dialogues are described in a later section, see “Dialogues’ on page 3-4.)
Again, if you don't want to debug those other processes, you should detach from them.

Another way to determine which processes are debugged is to use debug and nodebug,
which let you describe which processes you want to debug by their program names. See
“nodebug” on page 6-26.

One of the handy things NightView lets you do is group processes together into families.
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You do this by giving the family a name and telling the debugger what processes are in
that family. For example, you might have several processes executing the same program,
and you might want to set a breakpoint at the same source line in al of them. Y ou could
define a family containing all of the processes and then use that family name with the
breakpoint command. See“family” on page 6-48.

Sometimes you want to debug a process that is already running, rather than starting up a
new process running the same program. Y ou can do this with the attach command (see
“attach” on page 6-37) or with the Attach Dialog Box (see “Attach Dialog Box” on page
8-27.)

In order to attach to a process, you must know its process identifier (or PID). Y ou can get
a list of running processes and their PIDs by clicking on the Attach menu item in the
Process menu (see“Process Menu” on page 8-9) to bring up the Attach Dialog Box.

As an dternative, you can run the ps (1) program. You can use the shell command
(see “shell” on page 6-144) to run ps (1) . If you want to attach to a process running on
another machine, you may have to use the remote shell command (/usr/bin/rsh) to
runps (1) on the right machine.

Once you have attached to a process, you can debug it in the same way you would debug
aprocess started normally from a dialogue.

For the security restrictions on attach, see “ Attach Permissions’ on page 3-43.

If the process to which you attach is stopped (<CONTROL z> stops aforeground processin
most shells), then the attach will not take effect until the process is continued from the
shell.

Detaching a process is the inverse of attaching one. When you detach a process it starts
running independently of the debugger. Nothing it does will get the debugger's attention.
Any children it forks will also be ignored by the debugger. Y ou have to explicitly attach
to the process again to make the debugger noticeit.

Detaching from an exited or terminated process completely removes the process from the
system. See “Exited and Terminated Processes’ on page 3-19. Detaching from or killing
a pseudo-process associated with a core file (see “Core Files’ on page 3-4) is the only
way to make that pseudo-process go away.

Detaching from a process causes NightView to forget al the eventpoint settings and other
information it remembers about the process.

When detaching from a process under the RedHawk kernel, any patches installed in the
program for patchpoints, etc., will be left in the process and will continue to apply. When
detaching from a process with NightStar LX on a non-RedHawk kernel, any patches
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Core Files

Qualifiers

Dialogues
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installed will be removed before the detach occurs; they will not continue to apply after
the patch.

Attaching to a process from which you have detached is not supported on Linux. Avoid
detaching from processes unless you are sure you will not want to debug them further.

A core file is a snapshot image of a process created by the system when the process
aborts (typical reasons for creating a core file include referencing an address outside the
memory allocated to the process, dividing by zero, floating-point exceptions, etc.).
NightView alows you to debug core files as well as processes (see “core-file” on page
6-39). Since acorefileis not actually arunning process, al you can do islook at it. None
of the commands which reguire a running process will work on core files (for example,
you cannot continue a core file and you cannot evaluate any expression containing a
function call).

If acorefileisfrom a process that used dynamic linking, the core file must be debugged
on the same system where the process was running, otherwise information from the
libraries may not match the corefile.

If you are not debugging multiple processes, you will probably never need to worry about
command qualifiers, but for multiprocess debugging, they are essential. A qualifier is
used to restrict a command so it operates only on specific processes. There is always a
default qualifier in effect, but any command may be given an explicit qualifier.

Most qualified commands act as though the command was specified once for each
process (for instance, the breakpoint command sets a separate breakpoint in each of
the processes specified in its qualifier).

Some commands treat the qualifier in special ways, and other commands ignore the
qualifier. Any special treatment is described in the section on each command.

Qualifiers are specified as a prefix on the command. The complete description may be
found in “Command Syntax” on page 6-1 and “Qualifier Specifiers’ on page 6-15.

Diadlogues are one of the most important (and unique) concepts in NightView.
Essentialy, a dialogue is just an ordinary shell where you run commands as you would
normally run them in the shell (in fact, you are running your normal shell), but in a
dialogue, you have the opportunity to debug any or al of the programs you run in the
dialogue shell. Most debuggers have special commands to tell the debugger which
program to debug and what arguments to give it. In NightView, the way to debug a



Dialogue 1/0O

Concepts

program isto run it within adialogue shell. This means you can debug a program that isa
member of a pipe, or isinvoked by some other program, and you can run the program in
the debugger using the exact same invocation you would normally use outside the
debugger.

The environment variable NIGHTVIEW ENV is set to 1 within a dialogue shell. This
allows you to alter the behavior of programs and scripts running in the dialogue shell. For
example, you may wish to avoid running some programsin a shell initialization file when
the shell isadialogue shell.

NightView sets the TERM environment variable to dumb in the dialogue shell, to avoid
problems with some shell programs.

Once the shell is started, you can change directory, set environment variables, or set
ulimit (1) parametersjust like a normal shell. Any processes you start in the dialogue
will automatically be debugged, except for programs in the standard directories such as
/bin. You may dter this default behavior using the debug and nodebug commands.
See “debug” on page 6-25 and “nodebug” on page 6-26.

When you start a program in a dialogue shell, the debugger prints a message describing
the new process that just started in the dialogue. The information printed includes the
program name, the arguments it received on startup and the process identifier (PID). This
new process is stopped immediately prior to executing any code. At this point you can
decide what to do with the process (set breakpoints, etc.) and tell it to continue, or detach
fromit and let it run without being debugged.

At startup, NightView provides an initial dialogue named local. This initial dialogue
shell inherits the current working directory and environment variables in existence at the
time you started the debugger.

You may create additional dialogues at any time (see “login” on page 6-23). Multiple
dialogues alow you to debug distributed systems of processes running on different
computers. Each dialogue has a name. Unless you specify otherwise, the name of a
dialogue is the host name of the system to which it is connected. You may use dialogue
names in command qualifiers to tell NightView to which system you wish to talk, such
as, when you want to run acommand in a particular dialogue.

You send input to a dialogue shell or to a program you are debugging in the dialogue by
using the ' command (see “!” on page 6-32) or the run command (see “run” on page
6-35). The qualifier on the command determines which diaogue receives the input data.
In the graphical user interface, you can send input to a dialogue with a shell panel (see
“Shell Panel” on page 8-60) for that dialogue.

Since each dialogue is a separate shell, the programs running in separate dialogues may
generate output at any time. In the command-line interface, it would be confusing to have
these print at any time. Instead, all the output generated by each dialogue shell and the
programs running in it is logged by NightView. You can control thislog using the set -
show command (see “set-show” on page 6-33), and you can review the log with the
show command (see “show” on page 6-34). In the graphical user interface, dialogue
output goes to the dialogue 1/0 areafor that dialogue.
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Real-Time Debugging

By running NightView on a development system and starting a dialogue on a rea-time
system you are debugging, you can minimize the impact of the debugger on the real-time
system. Most of the debugger runs on the development system, and only a NightView
control program and the dialogue shell run on the real-time system. Y ou can also control
the CPU, memory, and other resource allocations of debugger processes to help minimize
the impact of the debugger on critical resources. See “Remote Dialogues’ on page 3-6.

Monitorpoints provide a means of monitoring the value of variables in your program
without stopping it. See “Monitorpoints’ on page 3-12.

NightTrace™ is another tool you may find useful in debugging real-time programs. It
alows you to gather performance information and record limited amounts of data with
minimal overhead. NightView provides facilities for using NightTrace from within the
debugger; see “Tracepoints’ on page 3-13.

Remote Dialogues

3-6

A remote dialogue is a 